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1. Introduction

Purpose

New Jersey is exposed to coastal flooding in the form of storm surge, sea level rise, and heavy
precipitation. Coastal areas experience flooding from hurricanes, tropical storms, nor’easters,
normal rainfall events, cyclical tidal events, and sustained on-shore wind or swell events that may
cause flooding even during clear skies. The extent of coastal flooding and location of areas
impacted depends on the combination of tides, storm surge, and rainfall (depth and intensity) at
the time of the event. This flooding is projected to increase in frequency and magnitude as a
result of climate change over the next century.

The following document describes the methods and processes used to produce flood inundation
maps for the regions selected as part of NJDEP’s Resilient NJ Program. These maps reflect both
current and future flooding events and will be used as planning tools for the Consultant Teams
to understand the level of potential risk the regions currently face, as well as future risk in light
of climate change. The output from these models will be used within the Resilient NJ Risk
Assessment Methodology. For further information on that process, refer to the separate Risk
Assessment Methodology document.

The STAP Report

The first New Jersey Science and Technical Advisory Panel (STAP) on Sea-Level Rise and Coastal
Storms was convened by Rutgers University on behalf of the NJ Climate Change Alliance in 2015,
culminating in a 2016 report that identified planning options for practitioners to enhance the
resilience of New Jersey’s people, places, and assets to sea-level rise, coastal storms, and the
resulting flood risk (Kopp et al., 2016). A panel of practitioners were convened to offer insights
on the application of the STAP science to state and local planning and decision-making; this
innovative approach was used to inform the 2016 report. Following the same process, the same
team at Rutgers University was engaged by the State of New Jersey Department of Environmental
Protection to update the 2016 report based on the most current scientific information. Similar to
the inaugural work, the 2019 STAP was charged with identifying and evaluating the most current
science on sea-level rise projections and changing coastal storms, considering the implications
for the practices and policies of local and regional stakeholders, and providing practical options
for stakeholders to incorporate science into risk-based decision processes. Table 1 below
summarizes the sea level rise findings from the 2019 STAP report.
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Table 1 Sea Level Rise Projections from the 2019 STAP Report

2030 | 2050 2070 2100 2150
Emissions |
Chance SLR Exceeds Mod.| High Mod.|High Mod.| High
LowEnd| > 95%chance 0.3 07 los| 1 [11]10]13]1s5)13]21]2e
_ > 83% chance 0.5 09 1312150172023 022]3.1]3238
Fla-l:negli ~50 % chance 0.8 14 |19]22]2a28]33[39]22]52]62
<17% chance 1.1 21 |27131(35039 5163|6383 (103
High End| < 5%chance 15 26 |32]38|4a50|69|88]|80(138[196

*2010 {2001-2019 average) Observed =0.2 ft

Notes: All values are 19-year means of sea-level measured with respect to a 1991-2009 baseline centered on the year indicated in the top row of
the table. Projections are based on Kopp et al. (2014), Rasmussen et al. (2018), and Bamber et al. (2019). Near-term projections (through 2050)
exhibit only minor sensitivity to different emissions scenarios (<0.1 feet). Low and high emissions scenarios correspond to global-mean warming
by 2100 of 2°C and 5°C above early Industrial (1850-1900) levels, respectively, or equivalently, about 1°C and 4°C above the current global mean
temperature. Moderate (Mod.) emissions are interpolated as the midpoint between the high- and low emissions scenarios and approximately
correspond to the warming expected under current global policies. Rows correspond to different projection probabilities. There is at least a 95%
chance of SLR exceeding the values in the ‘Low End’ row, while there is less than a 5% chance of exceeding the values in the ‘High End’ row. There
is at least a 66% chance that SLR will fall within the values in the ‘Likely Range’. Note that alternative methods may yield higher or lower estimates
of the chance of low-end and high-end outcomes. This table has been reproduced from New Jersey’s Rising Seas and Changing Coastal Storms:
Report of the 2019 Science and Technical Advisory Panel.

The Resilient NJ floodplain maps were produced for two current and four future flooding
conditions. The flooding conditions consider combinations of increased rainfall (both intensity

and depth), storm surge, tidal flooding, and sea level rise (SLR).

Flooding Condition Development

The development of the flooding conditions was based upon a combination of rainfall, storm
surge, sea level rise (SLR), and tidal flooding. Rainfall considers an intense, short-duration event
as well as alonger 24-hour event. No increase in rainfall depth was assumed for current condition
models; however, an increase of 10% in rainfall depth was assumed for storms occurring in 2070.
(Note: It is widely believed that precipitation amounts will increase within the next century;
however, there is uncertainty in the exact rate. A 10% increase was chosen for these models as
a central estimate of increased rainfall at 2070.) Storm surge baselines use the Mean Higher High
Water (MHHW) elevations reported at the Sandy Hook tide gauge (for northern regions) and the
Atlantic City tide gauge (for southern regions). (For regions within the Mullica-Toms watershed,
models were produced using both tide gauges. Since communities in this watershed may find
one tide gauge MHHW level more applicable to the region than the other, regions will choose
what they view as the appropriate MHHW level to use, with approval from DEP.) An increase of
2.4 feet was used for the 2070 SLR projection, which is the central estimate for the high emissions
scenario from 2019 Rutgers University’s Science and Technical Advisory Panel’s (STAP) report,
described earlier. Finally, a Sandy surge event equivalent, occurring in 2070, was also modeled.

See Figure 1 for tide gauges and corresponding watershed applicability.



Figure 1 Map of Divide Between Gauges Used for Mapping

GAUGE LOCATIONS |

Sandy Hook Gauge

Sandy Hook and Atlantic City Gauges
Aantic City Gauge

Final Flooding Conditions

Six (two current and four future) models displaying different potential flood conditions will be
provided to each region. Table 1 shows the different model inputs used for each of these
conditions.

Table 2 Flooding Conditions Available for Risk Assessment
Flooding Condition \ Type
Current a. MHHW + 2% annual chance, 2-hour storm event
b. MHHW + 1% annual chance, 24-hour storm event
Future c. MHHW + SLR 2070 (2.4 ft)
d. MHHW + SLR 2070 (2.4 ft) + (2% annual chance, 2-hour storm

event + 10% increase in rainfall)

e. MHHW + SLR 2070 (2.4 ft) + (1% annual chance, 24-hour storm
event + 10% increase in rainfall)

f. MHHW + SLR 2070 (2.4 ft) + Superstorm Sandy in 2070 (High
Water Mark = 8.3 ft)

Document Overview
The following document describes the methods and processes used to produce flood mapping
data for a selection of HUC-8 watersheds within New Jersey. Using the storm event factors
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described above, as well as terrain data, soil information, and land use data, floodplains were
developed using a two-dimensional (2-D) rain on grid model with HEC-RAS. Though the methods
used to produce the HEC-RAS 5.0.5 2D Unsteady Flow flood models are the primary focus of the
document, methods of data pre-processing in ESRI ArcMap, ArcHydro Tools, and USACE’s HEC-
HMS software are also detailed below. For information regarding the sources and applications of
raw data utilized within this process, see Appendices A, B, and C.

Model Selection
Multiple mapping methods were considered during preliminary map development. Some of
these methods included:

* Digitizing the New Jersey Flood Hazard Area Design Flood (NJFHADF)

* One-Dimensional Base Level Engineering Model (RiverSystems — A Michael Baker

proprietary software)
e Model Based Mapping of N.J.A.C. 7:13-3.5 (Method 5)- Approximate Method
* HEC-RAS Two-Dimensional Rain on Grid

Ultimately, the two-dimensional rain on grid model was chosen. This modeling method has the
ability to provide inundation maps for all areas of a region and was not only limited to state
studied streams. It was also one of the more straightforward modeling processes and could be
used to model multiple types of flooding events (rainfall, storm surge, etc).

Model Limitations

The terrain data obtained for use in this project, after being clipped to the buffered watershed
extents, was processed and reconditioned through ESRI’s ArcHydro Tools before being
incorporated into the HEC-RAS Models. The goal of ArcHydro Tools in this context was to correct
sections of the terrain that cause hydrologically disconnected areas, whether natural or artificial,
in the Digital Elevation Model (DEM). This was achieved by “burning” streamlines into the DEM,
providing hydraulic connectivity to areas that were previously (and usually incorrectly)
separated. While this method can correct hydraulically inaccurate areas within the DEM quickly
and for very large areas, it does not account for the characteristics of individual structures that
may affect hydraulics, such as bridges, culverts, or other constrictions and obstructions, which
was a potential source of inaccuracy in the models. Additionally, no specific stream bed, or
channel geometry data were used. Despite this concern, the similarity of floodplain results from
models using this method compared to the FEMA Special Flood Hazard Areas suggest that the
potential error does not greatly affect results.



Additionally, no urban drainage systems have been modeled. However, in the case of many
flooding events, these drainage systems can become quickly inundated, with excess water then
remaining on the terrain. Inthese cases, the model can indicate which areas are most vulnerable
to flooding events, but also what may occur when urban drainage is insufficient.

Finally, the maps developed through the methods described below are intended to be used as
planning tools for the Resilient NJ Program. These maps are not intended for regulation changes
or engineering design standard updates.

2. Terrain Preparation Using ArcHydro Tools

Background Information

Two ArcHydro routines were used for the preparation of the terrain files. The first, called DEM
Reconditioning, “burns” selected streamlines into the DEM to an elevation drop specified by the
user. The second process, Fill Sinks, refills these burn lines to the depth necessary to allow water
to flow unobstructed through the watershed to the exit point of the studied watershed. The
streamlines selected to be burned were lines from the National Hydrography Dataset (NHD). The
following NHD Flowline types were selected for this process:

Table 3 Selected NHD Flowlines and feature types for ArcHydro DEM Reconditioning
NHD Flowline FCode Feature Type
33400 CONNECTOR
42803 PIPELINE
55800 ARTIFICIAL PATH

These flowline feature types were selected to capture as many culverts, underground pipes, and
other hydraulic structures as possible that may not be reflected in the DEM or may have flow
paths blocked by artificial DEM structures.

NHD streamlines were cropped to a distance 1000’ from the edge of the DEMs (apart from Lower
Hudson, which was cropped to 250’ to the edge due to small watershed size). Because the original
HUS8 extents were buffered 3000’ for the creation of the DEMs, the burned streamlines still cover
the full extents of the original HU8 once processed in HEC-RAS. Cropping the streamlines was
necessary because the Fill Sinks process may not work properly if burned streamlines continue
to the very edge of the DEM.

Terrain Preparation
* In ablank MXD, import the DEM and NHD streamlines to be processed into ArcMap.
* Then save the MXD to the desired project folder at this point, as this will dictate where
ArcHydro Tools will attempt to deliver output files to.
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Once the MXD is saved, specify the file target locations in the ArcHydro Toolbar under
ApUtilities>Set Target Locations. Verify that the raster data is being delivered to a raster
workplace and that the vector data is being delivered to a file geodatabase. Verify that
the DEM is in ESRI GRID format and that the streamlines are shapefiles in file geodatabase
format, trimmed such that they do not reach the very edge of the DEM. It is also important
to ensure that the spatial projection of the data frame, streamlines, and DEM are all the
same.

From the ArcHydro Toolbar, select Terrain Preprocessing > DEM Manipulation > DEM
Reconditioning

The DEM Reconditioning routine in this workflow was done with default settings, shown
below.

Figure 2 Geometry of ArcHydro Tools’ DEM Reconditioning (“burn") routine

Streamn buffer (number of cells) 5
Smooth drop/raise (DEM Z-unit) 10
Sharp drop/raise (DEM Z-unit) 1000

Smooth drop/raise

Sharp drop/raise

Once complete, the output file, the AgreeDEM, is in the file target location specified by
the user in the ArcHydro Toolbar (or to a default location if unspecified). This
reconditioned DEM will contain reduced elevation DEM cells with elevation values
dropped by 1000’ per the sharp drop/raise settings where the selected streamlines were
located.

Once the AgreeDEM has been generated, the second ArcHydro process, called Fill Sinks,
further manipulates the terrain data. The Fill Sinks routine creates a hydrologically-
corrected DEM (HydroDEM). The HydroDEM is a terrain that attempts to capture the



correct drainage pattern within the watershed. Part of this process involves the analysis
and subsequent filling of sinks, which are areas of the terrain that trap water and do not
allow flow to continue through the dendritic stream system. Sinks in the terrain may be
real features or artificial features.

*  From the ArcHydro Toolbar, select Terrain Processing - DEM Manipulation - Fill Sinks.

Once these two processes have been completed, the original terrain file will be a
hydrologically-corrected DEM that will serve as the terrain data for the HEC-RAS 2D
Unsteady Flow Model.

Figure 3 Default Settings and Inputs for Fill Sinks
@ Fill Sinks ‘ e - =]
Hydro DEM HydroDEM
[] Use IsSink Field
Fill Method

() Fill Threshald (DEM Z-Unit) 10
@ Fill Al
o< | [ Hele ][ Cancel

3. Determining a Weighted Curve Number

Background Information

The SCS runoff curve number method was used in this process to determine what proportion of
precipitation that falls within the watershed is expected to be captured or become runoff. By
using land use data provided by the NJDEP (and NLCD data where applicable), a single weighted
curve number was generated for each watershed and inputted into a HEC-HMS model to
approximate the excess runoff the watershed will encounter. This method uses approximate
values to simplify runoff calculations over large areas. Localized conditions may be considered on
a case by case basis, where runoff values may differ from the assigned curve numbers.

Two primary data sources were used to estimate curve numbers within the watersheds: land use
and soils. The land use used landcover polygons from New Jersey DEP for in-state areas and
National Land Cover Dataset (NLCD 2011) for areas outside of the state boundary. Soil data was
collected from the Natural Resources Conversation Service (NRCS) Web Soil Survey, in SSURGO
format. Based on tables found on the Web Soil Survey website, each soil type was assigned a
Hydrologic Soil Group (HSG) classification (A, B, C, or D). These classifications describe a soil’s rate
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of transmission of water, which influences the amount of stormwater runoff that a surface with
that soil type may generate.

The curve numbers used were derived from Table 2-2 in NRCS’ “Urban Hydrology for Small
Watersheds” (TR-55), which provides a curve number for combinations of land use type and
hydrologic soil group classification. By relating land use and soil types to the closest matching TR-
55 land use type and HSG (and by making assumptions where appropriate), a similar curve
number rating system was generated for any combination of New Jersey Land Use type and HSG
type (and/or NLCD Land Use type and HSG type for non-NJ areas). Refer to Appendix C for a
detailed breakdown of these numbers. Curve numbers were assigned to every combination of
soil and land use across each watershed, then weighted by the curve number and area of each
combination polygon, and as a result a single weighted curve number was generated for each
watershed.

Generating SCS Curve Numbers in ArcGIS
Figure 4 Shapefile Soils and Land Use Data clipped to watershed extents, to be combined
to create land use and soils combination polygons (ArcMap)

e Start with land use and soils polygons in shapefile format in ArcMap, clipped to the
buffered (3000’) extents of the watershed. Use the Union tool to combine the two
datasets and merge the attributes.



Figure 5 Combining datasets with Union tool (ArcMap)

Input Features

Features
< s0ils02040302
<> LU02040302

* Next, using the Join function in ArcMap, join the SSURGO soil codes (field MUSYM) to a
table that links the MUSYM codes to a corresponding HSG.

Figure 6 Performing a join to an external excel file (ArcMap)

Join lets you append additional data to this layer's attribute table so you can,
for example, symbalize the layer's features using this data.

L= euyers | |

[ERE] LU Soils_ Union

What do you want to join to this layer?

Join attributes from a table -
[ ] B Copy
(= O LU02040302| ¥ Remove
o 1. Choose the field in this layer that the join will be based on:

B Open Attribute Table

= M s0ils020403

= Joins and Relates 3 Jain. ” MUSYM -
& Zoom To Layer Remove Join(s) 2. Choose the table to join to this layer, or load the table from disk:
Zoom To Make Visible Relate... Join
Visible Scale Range R Remove Relate Join data to this layer or I SSURGO_to_HSGS 7]

standalone table based on
a common attribute,

spatial location or existing
relationship class.

| Show the attribute tables of layers in this list
Use Symbol Levels 1y

Selection 4

w

. Chaose the field in the table to base the join on:

Label Features Soil_Type -

Edit Features 4
- Join Options
(@) Keep all records

Soluis S IEET All records in the target table are shown in the resulting table.
Convert Symbology to Representation... Unmatched records will contain null values for all fields being
i 9y 10 Rep appended into the target table from the join table.
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Data 4
< Save As Layer File.. (7) Keep only matching records
@ Create Layer Package. If a record in the target table doesn't have a match in the join
| [r— table, that record is removed from the resulting target table.
roperties...

Validate Join

* Now, Add Field to the attribute table, and use Field Calculator on the newly created field
to combine the NJLU and HSG fields together, creating single codes which denote a
combination of NJ LU code and HSG (such as 1110A or 4200C) for a specific polygon in the
dataset, seen as LU12_HSG in the attribute table below.

e Join these codes to a table that matches LU+HSG codes to a curve number value, and this
will provide curve numbers for the unioned land use/soils polygons.

* Once this is complete, Add Field again, and use Calculate Geometry to determine the
area of each polygon, and export the data to Excel. Once the data is in excel, generate a
weighted curve number for the watershed.




Figure 7 Curve Numbers and Polygon Area calculated in the LU+Soils Unioned
dataset. For watersheds that contain NLCD data as well as NJ Land use
data, a similar process was used to convert the NLCD and Soils data into
curve numbers, where combinations of NLCD grid codes and soils data
were paired to a curve number table.

> Table
union2
FID LU12 LABEL12 MUSYM | HSG LU12 H5G CN Code Area
4172 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY DuoC A 1120A 57 | 1120A 151934
4173 1130 | RESIDENTIAL, SINGLE UNIT, LOW DENSITY DuoC A 1130A 51| 1130A 124629
4174 4120 | DECIDUQOUS FOREST (»50% CROWN CLOSURE) DuoC A 4120A 30 | 4120A 320854
4175 4120 | DECIDUOUS FOREST (»50% CROWN CLOSURE) DuoC A 4120A 30 | 4120A 9697
4176 6210 | DECIDUOUS WOODED WETLANDS DuoC A 6210A 87 5| 6210A 24902
4177 6210 | DECIDUOUS WOODED WETLANDS DuoC A 6210A 87.5 | 6210A 109418
4178 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY DuuC A 1120A 57 | 1120A 220840
° 4179 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY DuuC A 1120A 57 | 1120A 269362
4180 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY DuuC A 1120A 57 | 1120A 38644
I 4181 1463 | UPLAND RIGHTS-OF-WAY UNDEVELOPED DuuC A 1463A 36 | 1463A 27025
4182 4120 | DECIDUQOUS FOREST (»50% CROWN CLOSURE) DuuC A 4120A 30 | 4120A 68046
h 4183 4120 | DECIDUOUS FOREST (»50% CROWN CLOSURE) DuuC A 4120A 30 | 4120A 5190
4184 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY WemC C 1120C 81| 1120C 56530
u 4185 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY WemC C 1120C 81| 1120C 23406
4186 1130 | RESIDENTIAL, SINGLE UNIT, LOW DENSITY WemC C 1130C 79 | 1130C 4563
: 4187 1140 | RESIDENTIAL, RURAL, SINGLE UNIT WemC |C 1140C 77 [ 1140C 74325
» 4188 1200 | COMMERCIAL/SERVICES WemC C 1200C 94 [ 1200C 8926
4189 1463 | UPLAND RIGHTS-OF-WAY UNDEVELOPED WemC C 1463C 73 | 1463C 16358
w 4190 1710 | CEMETERY WemC C 1710C 74 | 1710C 141925
4191 1110 | RESIDENTIAL, HIGH DENSITY OR MULTIPLE DWELLING DuuB A 1110A 77 | 1110A 1140
z 4192 1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY DuuB A 1120A 57 | 1120A 429766
4193 1140 | RESIDENTIAL, RURAL, SINGLE UNIT DuuB A 1140A 46 | 11404 106986
| 4194 4120 | DECIDUOUS FOREST (»50% CROWN CLOSURE) DuuB A 4120A 30 | 4120A 125
m 4195 1110 | RESIDENTIAL, HIGH DENSITY OR MULTIPLE DWELLING DuuD A 1110A 77 [ 1110A 110352
4196 1120 | RESIDENTIAL,, SINGLE UNIT, MEDIUM DENSITY DuuD A 1120A 57 | 1120A 109244
m 4197 1200 | COMMERCIAL/SERVICES DuuD A 1200A 89 | 1200A 10215
4198 1200 | COMMERCIAL/SERVICES DuuD A 1200A 89 | 1200A 22362
< 4199 1200 | COMMERCIAL/SERVICES DuuD A 1200A 89 | 1200A 28317
L 4200 1420 | RAILROADS DuuD A 1420A 76 | 1420A 29
E “o« 4189 » v B[S (0 outof 217937 Selected)
{ union2 I
*
3 Figure 8 Weighted Curve Number determined by X(CN*A)/2(A)
- 6 |
Q Weighted Curve Number |CN,,qgiec = E(CN*AYE(A)
o 78.1
CN1 Area (Sq F Area®CN (Sq Ft)
77 51268 3947636
87 1474 128238
87 14824 1289688
77 9171 706167
77 514 39578
77 6130 472010
77 3556 273812
87 7226 628662
84 9685 813540
87 9686 842682
87 6049 526263
84 19316 1622544
77 6632 510664
77 2348 180796
77 10726 825902

77 33856 2606912
77 30724 2365748
84 17366 1458744
77 968A 745822




4. Determining Precipitation Excess in HEC-HMS

Background Information

Precipitation data for this process were based around both a 1%, 24-hour storm event, and a 2%,
2-hour storm event. The 100-year, 24-hr distribution is a standard design storm used in flood
mapping (especially regulatory mapping). However, changes in climate patterns are resulting in
anincreasing frequency of short, intense storms which may overwhelm stormwater drainage and
impoundment systems and contribute to localized flooding outside of the floodplain. Therefore,
both precipitation events were modeled for both current and future flooding conditions.
Precipitation depths were increased by 10% when modeling flooding conditions for the year
2070.

Precipitation data was obtained in GIS format from the NOAA Precipitation Frequency Data
Server, which provides values derived from NOAA Atlas 14 in the form of precipitation depth
rasters. The rasters were then clipped to watershed extents, and the Zonal Statistics tool in GIS
was performed on the clipped rasters to generate a mean rainfall value for the watershed.
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Figure 9 Determining mean rainfall depth from NOAA precipitation rasters
#, Zonal Statistics @@ﬁ
Click error and warning icons for more information B -~ Zonal Statistics
Input raster or feature zone data o
|MOd1‘ﬁEdHU8(QU€W) A E. Calculates statistics on
. values of a raster
Zone field within the zones of
HUS e another dataset.
| Input value raster o
| precip_40302.tit fal =]
Output raster
C:\Temp\NIRRGP_Data\zonalstat302.tif [g|
II Statistics type (optional)
MEAN -
[¥]Ignore NoData in calculations (optional)
OK ] | Cancel l [ Envimnmenls...] [ << Hide Help l I Tool Help |

After determining the rainfall depths, HEC-HMS models were built to simulate the hydrologic
processes of the watershed system, generating a precipitation excess hyetograph that would
serve as the input for the Unsteady Flow files in the HEC-RAS models. The SCS Curve Number
method was used to compute the excess runoff that would not be captured within the
watershed, using the weighted curve number computed in Section 3.




HEC-HMS Process

* To compute the excess runoff in the watershed, begin with a new HEC-HMS Model, and

create a new project.

e Be sure to set the default unit system to U.S. Customary.

Figure 10

Creating a HEC-HMS model

-

Z Create a New Project

Name:
Description:

Location:

Default Unit System: |

HU02040302

Great Egg Harbor
C:\Temp

L

| l Create ” Cancel IJ

Figure 11 Creating a basin/sub-basin model

. HEC-HMS 4.2.1 [C:\Users\Alexander.Liptak\Desktop\HMSTest\HU02040302\HU02040302.hms] =k

Eile Edit View Components Parameters Compute Results Tools Help

O @ & LI 3 E = P g P ;_*1 --None Selected—- :——Nnne Selected--

. HU02040302
(= . Basin Models

287 ]basin 1]

~% B E | e

b -

) Basin Model [Basin 1]

& Subbasin-i

Components | Computel Resu\ts‘

£5) Basin Model ‘

NHame: Basin 1

Description:

Grid Cell File:
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Local Flow: | No

Flow Ratios: | No

NOTE 10008: Begin opening project "HU02040302% in directory
"C\Users\Alexander.Liptak\Desktop\HMSTest\HUO 2040302 at time 185ep2018, 08:35:20.
MNOTE 10019: Finished opening project "HU02040302" in directory

*C:\Users\Alexander. Liptak\Desktop\HMSTest HU02040302" at time 185ep2018, 08:35:21.

Replace Missing: :No
Unit System: | U.5. Customary

Sediment: :No

Water Quality: | No

* Name and describe (optional) the project and save it to the project folder.

e Next, select Components = Basin Model Manager and create a new Basin.

* Once the basin is created and named, click the Subbasin Creation Tool on the toolbar.

e Then, with the Subbasin Creation Tool selected, click anywhere in the Basin Model
window to create a sub-basin.

¢ Once the Sub-basin has been created, select the sub-basin and view the sub-basin model
settings. Select Loss Method: SCS Curve Number.

e Then, go to the Loss tab in the sub-basin model settings, and input the computed
weighted curve number.




Figure 12 Specifying loss method for a basin/sub-basin model
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Figure 13 Inputting weighted curve number into HMS
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e Next, select Components - Meteorologic Model Manager, and Create a new
meteorologic model.




Figure 14 Creating a Meteorology Model in HMS
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Description: =l
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Evapotranspiration: | --None-- v
Snowmelt: | —None-- v
Replace Missing: ' Abort Compute v

For modeling the 1%, 24-hour storm event:

* Inthe Meteorology Model settings, set Precipitation: to Hypothetical Storm.

¢ On the next tab, Basins, select Yes under Include Subbasins.

* Next, select Hypothetical Storm under Meteorological Models. Select SCSType 3 for
Method, and input 1.10x the mean value calculated (this multiplier accounts for
expected increase in future severity and frequency of storms) from the Zonal Statistics
Tool in ArcMap in the Depth (IN) field.

Figure 15 Specifying rainfall depth in the Meteorological Model
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Hypothetical Storm

Method: |SCS Type 3 v
*Point Depth (IN) | 10.325
Area Reduction: | --None-- v




For modeling the 2%, 2-hour storm event:

Precipitation data for the 2%, 2-hour storm event was determined based on NOAA rainfall
data (discussed earlier) and the water quality storm distribution from the NJDEP BMP
manual for the 1.25” depth (Figure 16).

Figure 16 NJDEP Water Quality Design Storm

Figure 5-2: NJDEP 1.25-Inch/2-Hour Stormwater Quality Design Storm
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The 15-minute incremental depths were then determined based on this curve for the 1
inch depth. The 1-minute incremental depths were then extracted based on the 15-
minute distribution (Figure 17). The 2% rainfall depths for each HUC-8 were multiplied
by the 1 minute distribution to obtain time series data to be used within HEC-HMS.
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Figure 17 NJDEP Water Quality Design Storm Incremental Precipitation
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* To import time series data into HEC-HMS select Components - Time Series Data
Manager. Create a new time series data with the Data Type: Precipitation Gages

e In the time series data tab—> precipitation gages—> select manual entry in
incremental inches at a 1-minute time interval.

Figure 18 Specify Time Series Gage
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Components Compute Results
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Description: 1=
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Time Interval: | 1 Minute '




e Choose a date range that the model will run for by selecting the date below the time
series event and filling out the time window:

Figure 19 Model Time Window

El- | Time-Series Data
E} Precipitation Gages
£ 2%2h
: 01]an2020, 00:00 - 03Jan2020, 00:00
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Components Compute  Results
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*Start Time (HH:mm) |00:00
*End Date (ddMMMYYYY) |03Jan2020
*End Time (HH:mm) (00:00

* Last step in the time series data manager is to fill out the precipitation table with the
1-minute distribution for the 2%, 2- hour storm.

Figure 20 Model Time Window
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Components  Compute  Results

B%Tlme—Series Gage Time Window Table Graph

Time {ddMMMYYYY, HH:mm) Precipitation {IM)

01Jan2020, 00:00 ~
01Jan2020, 00:01 0. 0000000
01Jan2020, 00:02 0,0008613
01Jan2020, 00:03 0,0017226
01Jan2020, 00:04 0,0025340
01Jan2020, 00:05 0,0034453
01Jan2020, 00:06 0,0043068
01Jan2020, 00:07 0.0043066
013an2020, 00:08 0.0043065
013an2020, 00:09 0.0043065
01Jan2020, 00:10 0.0043065
01Jan2020, 00:11 0.0043065
01Jan2020, 00:12 0.0043170




* The final input in the HEC-HMS process is to specify the duration and time interval of the
model. Select Components = Control Specifications Manager to create a new control
specification.

Figure 21 Specifying time controls
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Name: Control 1
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Time Interval: :1 Minute v:

* The basin, storm, and time information have now been defined. The last step is to create
a run file and run the model. Select Compute = Simulation Run Manager and create a
new simulation run. Select the Compute tab, specify the desired output of the DSS file
(this will be imported into HEC-RAS for precipitation data), and click the Compute Current
Run icon in the toolbar.
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Figure 22 Successful computation of HEC-HMS model
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This will write the excess precipitation hyetograph (among additional data) to the .DSS
file at the specified location. Save and Close HEC-HMS.

5. Building a HEC-RAS 2D Unsteady Flow Model

The flood mapping files were generated from 2D Unsteady Flow Models in HEC-RAS 5.0.5. These
models use a precipitation hyetograph on a 2D computational mesh grid to compute water
elevation, velocity, and depth across the watershed over a defined time period.

Starting a New Project
e To begin building a model, open HEC-RAS 5.0.5. Select File > New Project.
* Name the project and save it to the local drive. Next, open RAS Mapper:
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Figure 23 New HEC-RAS Project
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| e

Geometry:
Steady Flow:
Unsteady Flow: |
Description : | A J | US Customary Units

* Once in RAS Mapper, specify the spatial projection for the project. This is done by
selecting a file with the same projection as the one used in the model. Select Tools - Set
Projection for Project, and select a file (such as a .shp file) with the desired projection.

Figure 24 Setting Spatial Projection for a Project
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Creating a Terrain
* Now, import the hydrologically-corrected terrain into RAS Mapper. To begin, select Tools
- New Terrain. It is recommended to convert the terrain file to .tif format before
continuing with this step. Navigate to the HydroDEM file, select it, and then select Create
in the New Terrain Layer window. This will begin processing the terrain file and importing
it into RAS. This may take some time. Once completed, save and close RAS Mapper.

Creating a Land Cover Layer

The next step in building the model is to assign friction coefficients (Manning’s N) to the terrain
surface. This is done by importing Land Cover Data (NJ Land Use Data), associating it with the
terrain file, and assigning a Manning’s N value for each land cover type. The Manning’s N values



were determined using TR-55 roughness coefficients values in combination with roughness
coefficients from Chow (1959) and Calenda, et al. (2005).

* The first step in creating a new land cover layer is to open RAS Mapper, and select
Tools>New Land Cover.

* Next, in the resulting Manning’s n Value Layer window, press the il symbol to select the
land cover file.

Figure 25 Adding a Land Cover file
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Figure 26 Assigning custom Manning's N values to a land cover file.
Manning's n Value Layer e S S T —__" ..
~Input Files
Import Extents:  |Geometries [(Custom) | [LasELTZ | m
il Filename | Projection | Naming Std. | Name Field | Mann. N Field
il LU02040302.shp (Same as Project) | 83509 of 83509 Poly... (Custom) LABEL12 (Custom)

<]
]

Selected File Land Cover |dentifiers

~Output File

RESIDENTIAL, SINGLE UNI...

I MName Field | Description o
RESIBENTIAL HIGH DENSE eSS n]S IR o le] gl B]=TN

RESIDENTIAL, SINGLE UNI...

RESIDENTIAL, SINGLE UNI...

RESIDENTIAL, SINGLE UNI...

RESIDENTIAL, RURAL, SIM...

RESIDENTIAL, RURAL, SIN...

MIXED RESIDENTIAL

MIXED RESIDENTIAL

RAS Description

AGRICULTURAL WETLA .

AIRPORT FACILITIES

ALTERED LANDS

ARTIFICIAL LAKES

COMMERCIAL/SERVICES COMMERCIAL/SERVICES ATHLETIC FIELDS (SCH

MILITARY INSTALLATIONS | MILITARY INSTALLATIONS ATLANTIC OCEAN
I INDUSTRIAL INDUSTRIAL ATLANTIC WHITE CEDA..

BEACHES BEACHES il BARE EXPOSED ROCK,.. |8

Output 1D Standards: ~ [(Custom) ~|
Cell Size: 10 feet Qutput Size: ~7MB
i Filename: |ﬁ\. \7_HEC-RAS\HEC-RAS\Mannings_n.hdf = |
Create | Cancel |

[ — — =

* Once the appropriate land cover layer is determined, select the field to be used for Land
Cover ldentifiers (in this case the labels for the NJ LU12 codes, seen as LABEL12), and
select (Custom).

* Assign custom Manning’s N values to the land use types found within the selected data.

* Once all land cover types have been assigned a Manning’s N value, press Create to
complete the land cover layer. Refer to Appendix B for a table of the Manning’s N values
used in these models.

e For watersheds that combine NJ Land Use data and NLCD Data, convert the NLCD raster
to polygons, then assign the grid codes in the NLCD data to a New Jersey Land Use
category that shares the same Manning’s N. Now, all the land use data will be classified
by the same set of labels. Merge the two datasets together and use the combined dataset
as the land cover input file.
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Creating a 2D Mesh Computational Grid

The next step in the creation of the model is generating the 2D mesh grid. This computational
grid defines the extents of the computational area within the watershed. The user must define
the cell size of the 2D Grid.

e To start, obtain a shapefile with the extents of the watershed in GIS.




* Using the Feature Vertices to Points tool, convert the shapefile into a polygon with points
at each vertex.

Figure 27 Converting HUS8 outline to points
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Figure 28 HUS8 Outline in Points
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* Next, add coordinates to these points so that they may be brought into HEC-RAS. The Add
XY Coordinates (Data Management) tool will add two columns to the attribute table of




the points layer, one for X and one for Y. Make sure that the projection of the points layer
is set to the same projection as the HEC-RAS model.

* OncetheXandY coordinates have been defined, export the data so it can later be brought
into HEC-RAS. A simple way to do this is the Table to Excel tool, which will export the
attribute table of the point layer into a Microsoft Excel file. From the Excel file that is
generated, simply select the X and Y coordinates of the extents layer, copy to the
clipboard, and return to HEC-RAS.

* Inthe Geometry Window, select 2D Flow Area in the Tools toolbar.

Figure 29 2D Flow Area Creation Tool
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* Draw a small polygon and double click to finalize.
* Name the grid and click on the newly created polygon, then select Edit 2D Flow Area
window.

Figure 30 Editing a 2D Flow Area
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* In the Edit 2D Flow Area window, select GIS Outline. In this window, it is possible to
replace the coordinates of the small placeholder shape created with the coordinates
copied from the excel file.

Figure 31 2D Flow Area Editor Window
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Figure 32

Replacing dummy coordinates with HU8 outline coordinates
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* Once the coordinates are pasted into the table, press OK. In the 2D Flow Areas editor
window, press OK.

* The new watershed extents generated will likely exceed the view extents of the previously
drawn 2D shape. To view the new extents of the 2D Flow Area, Select View > Set
Schematic Plot Extents. Then, select Set to Computed Extents.

Figure 33 Reset geometry window to computed extents
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Figure 34 2D Grid with extents of HU8
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* Press OK and return to the geometry window and review the extent of the watershed in
the geometry window.

* Specify the cell sizing and alignment and generate the grid. Go back to the 2D Flow Area
editor window and select Generate Computation Points on Regular Interval with All
Breaklines.

Figure 35 Generating computational cells in the 2D mesh

. .
2D Flow Area: [2D_Grid ] ﬂ ﬂ - Slorce QI

Connections and References to this 2D Flow Area

D=
=
el
(=
Q
(=)
=
[
LLl
=
O
=
o.
o.
<
=
=
<
el
Q.
Q
8
el
L

-

-

Defaullt Manning's n Value: 0.06 2D Flow Area Computation Points

Edit Land Cover to Manning's ... | Current mesh contains no computation points.
Cell Volume Filter Tol (0=0FF)(ft): 0.01

Cell Minimum Surface Area Fraction (0=0FF){0-01
S Minimum surlace Area Fr X R I Generate Computation Points on Regular Interval with All Breakiines... |I

= . 0.01
Eace Broliclite ol GRENTLE Enforce Selected Breaklines (and internal Connections) ... |

-] - : 0.01
Face Area-Elev Fiter Tol (0=0FF)(ft): View/Edit Computation PInts ... |

Face Conveyance Tol Ratio (min=0.0001): |9.02
Face Laminar Depth (0=0FF)(ft): 0.2

GIS Outiine ... | Force Mesh Recomputation |




* The resulting window will allow the user to specify the cell size and to shift the cells from
the default computed position.

Cell sizing for this process was selected at 196.8’, to be as close to 200°'x200’ (industry
standard) cell sizing while still allowing DEM cells to be wholly divisible within each
computational cell (60 terrain cells wide at 3.28" per cell = 196.8’ wide computational
cells).

Figure 36 Specifying computational grid cell size
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¢ Select Generate Points in 2D Flow Area, return to the 2D Flow Areas window, and select
OK. HEC-RAS will then generate the 2D mesh grid, which should appear in the Geometry
Window once it is done computing.

Figure 37 Completed 2D computational mesh
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Aligning Computational Cells with Terrain Cells (Optional)
An optional step in this process is to align the edges of the terrain cells with the cells of the 2D
mesh grid.

* To achieve this, go to RAS Mapper, right click Terrain, and select Image Display
Properties.
* Inthe properties window, select Plot cell outlines (when zoomed in).

Figure 38 Viewing terrain cell outlines
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* Next, zoom in to a corner of a computational cell in RAS Mapper until the boundaries of
the terrain cells appear.

e Using the Measure distance tool, measure the required shift in terms of Shift Right and
Shift Up. View the measured distance in the bottom left of the RAS Mapper window for a
higher precision measurement.
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Figure 39 Measuring distance to higher precision in RAS Mapper
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Figure 40 Measuring required Right and Up shift of computational cells
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* Return to the geometry window, open the 2D Flow Area editor window, and again select
Generate Computation Points on Regular Interval with All Breaklines. Enter the shifts
into the editor window that appears.




* Re-generate the 2D Flow Area and return to RAS Mapper to inspect the changes. The faces
of the terrain cells should now align with the faces of the computational cells.

Figure 41 Shifting generated computational cells
"2 row r2z: N -
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Creating 2D Flow Area Boundary Condition Lines

A crucial step in building a HEC-RAS model is defining the boundary conditions of the model,
particularly the tailwater elevation and location of the exit point. For 2D models, the boundary
condition line is drawn at the exit point of the modeled area along the cell faces that make up
the edge of the 2D mesh grid. In the example used below, a coastal HU8 has a boundary condition
line that runs all along the coastal face of the watershed. Watersheds with a riverine boundary
condition will draw the boundary condition line across the waterway at the exit point of the
watershed.

This modeling process derived boundary condition values from two tidal gages, one located in
Sandy Hook, NJ (Station ID 8531680) and the other in Atlantic City, NJ (Station ID 8534720). Mean
Higher High Water (MHHW) gage datum elevations were converted to NAVD88 and then water




>
5
(=
(=]
o
o =
-
il
=
O
=
o
o
<L
=
=
"
(=]
&
—
LL

surface elevation increases corresponding to sea level rise and/or storm surge conditions (where
appropriate) were added to the gage elevations. See the introduction earlier in this document or
the Risk Assessment Methodology for more information on boundary condition values used and
the flooding conditions those values are associated with.

* To specify the location of the boundary condition line in a 2D Model, begin by opening
the Geometry Window.

e In the Tools toolbar, select SA/2D Area BC Lines. This will turn the cursor into a pencil,
allowing the user to specify the start point of the boundary condition line. Place the start
point outside of the computational grid, but close to the cell that is the start of the
boundary condition. Precision is not necessary when drawing boundary condition lines,
as HEC-RAS will snap the line to the edge of the computational grid once the user is done
drawing.

Figure 42 Drawing boundary condition lines on the 2D Grid




* To complete the boundary condition line, draw to the desired endpoint of the boundary
condition and double click. This will finish the line and a prompt to name the boundary
condition will appear.

* Name the boundary condition line and save the geometry file.

Creating Unsteady Flow Files

The final step in creating the HEC-RAS model is to create the unsteady flow files, which contain
data regarding the boundary condition tailwater elevation and the data contained in the stage
hydrograph from HEC-HMS. One unsteady flow file will be created for each boundary condition
that is being modeled.

Figure 43 Boundary Condition Line (Red and Black) snapped to 2D Grid Extents

B HEC-RAS 5.0.5

File Edit Run View Options GIS Tools Help
SEIETSE ) Sl e L P N IS

Project: [RAS02040302 |C:\.-.\Desktop\ModesforQC\RAS02040302\HEC-RAS\RAS02040302(BC_AC).prj | 3

Plan: | |

Geometry: Jwalkthrough_test |C:\...\Desktop\ModelsforQC\RAS02040302\HEC-RAS\RASD2040302(BC_AC).g02
Steady Flow: | |

Unsteady Flow: |MHHW+9 IC:\...\DeSktOp\MOdeEforQC\RASDZD403DZ\HEC-RAS\RASDZMDBDZ(BC_AC).UDZ
Description : I - J I US Customary Units

» To start, select View/Edit Unsteady Flow Data in the HEC-RAS main window.

* In the Unsteady Flow Data window, select File>New Unsteady Flow Data. Name and
save the file to the project folder. In the Unsteady Flow Data window, the previously
defined Boundary Condition line will appear under Storage/2D Flow Areas.

* To define the tailwater elevation of the Boundary Condition, select “Stage Hydrograph”
under Boundary Condition Types.

Figure 44 Assigning tailwater elevations to the boundary condition line
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* In the Stage Hydrograph window, select a Data time interval that will provide elevation
values at all simulation timesteps in the model.

* To enter this, enter the tailwater elevation under Stage (ft) for the first and last timesteps
in the hydrograph, then select Interpolate Missing Values to fill in the rest.

* Next, select Add SA/2D Flow Area.

e Select the 2D grid created and add it to the Select Storage Areas for BC’s list. Press OK
to confirm.

* Close the window and select Precipitation from the Boundary Condition Types.

* Now, import the hyetograph data from HEC-HMS into RAS. In the Precipitation
Hydrograph window, select Read from DSS Before Simulation and Select DSS file and
Path. This is where the model run DSS file that was generated in HEC-HMS is located.

Figure 45 Select only the PRECIP-EXCESS files from the HMS run.
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* Find the .DSS file created by the HEC-HMS run, and select the PRECIP-EXCESS pathnames.
This will serve as the precipitation hyetograph for the model.

Figure 46 Linking HEC-HMS excess precipitation to HEC-RAS

Ereos e I ==

DSS File: IC:\Users\Alexander.Liptak\Desk‘top\ModelsforQC\RAsD2D4UEU2\HEC—HMS\R| Ll ﬂ Update Catalog |

Part A Part B Part C Part D Part E Part F - |

SUBBASIN-1 PRECIP-CUM 10MAY2018 1MIN RUN:RUN 1
SUBBASIN-1 PRECIP-CUM 11IMAY2018 1MIN RUN:RUN 1

PRECIP-EXCESS
PRECIP-EXCESS
|SUBBASIN-1 | PRECIP-EXCES! 09MAY2018
PRECIP-EXCES:
PRECIP-EXCESS
|SUBBASIN-1 | PRECIP-EXCESS 12MAY2018

SUBBASI-T PRECID EACESS COM TEMAT 2015 TV O - RO T

SUBBASIN-1 PRECIP-EXCESS-CUM 07MAY2018 1MIN RUN:RUN 1

SUBBASIN-1 PRECIP-EXCESS-CUM 08MAY2018 1MIN RUN:RUN 1

SUBBASIN-1 PRECIP-EXCESS-CUM 0SMAY2018 1MIN RUN:RUN 1

SUBBASIN-1 PRECIP-EXCESS-CUM 10MAY2018 1MIN RUN:RUN 1 =
»

Select entire fitered list Select highlighted DSS Pathname(s) | I << Previous || Mext=> |

//SUBBASIN-1/PRECIP-EXCESS/07MAY201 /RUNRUN 1/
//SUBBASIN-1/PRECIP-EXCESS/08MAY2018/1MIN/RUN:RUN 1/
//SUBBASIN-1/PRECIP-EXCESS/09MAY2018/1MIN/RUN:RUN 1/
//SUBBASIN-1/PRECIP-EXCESS/10MAY2018/1MIN/RUN:RUN 1/

J//SUBBASIN-1/PRECIP-EXCESS/1 1MAY2018/1MIN/RUN:RUN 1/
//SUBBASIN-1/PRECIP-EXCESS/12MAY2018/1MIN/RUN:RUN 1/

Plot Selected Pathname(s) | Clear List | OK | |

* Press OK and return to the Unsteady Flow window.

* To create additional Unsteady Flow files with other boundary conditions, simply change
the tailwater elevation values in the boundary condition stage hydrograph editor, and
Save As... to a new unsteady flow file.

* Once the desired Unsteady flow files have been created, it is time to run the model.

Figure 47 Unsteady Flow Simulation from the HEC-RAS main window

r
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Description : I
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* Back in the HEC-RAS main window, select the Unsteady Flow Simulation button. This will
bring up the Unsteady Flow analysis window. Here, create plan files that specify and save
the selections of the Geometry file, Unsteady flow file, computation settings, and more.
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Figure 48 Specifying desired files and settings for a run Plan file

% Unsteady Flow Analysis u

File Options Help

Plan : Mean_Sea_Level Short ID: [MHHW+9

Geometry Fie : |02040302_2DGRID(196.8")

Unsteady Flow File : |Mean_Sea_LeveI
—Programs to Run————— ~ Plan Description
v Geometry Preprocessor
[¥ Unsteady Flow Simulation
[~ Sediment
[v  Post Processor

[v Floodplain Mapping

— Simulation Time Window -
Starting Date: 07MAY2018 _| Starting Time:

Ending Date: 13MAY2018 _| Ending Time:

—Computation Settings
Computation Interval: 30 Minute - J Hydrograph Output Interval: |1 Hour

Mapping Output Interval: |1 Hour | Detailed Output Interval: 1 Hour
DSS Output Filename: |C:\Users\,Alexander.Liptak\Desktop\ModeksforQC\RASDZ04030 El

-
-

Time Step is controlled by time series of divisors.

Compute

The new (to HEC-RAS) variable timestep function was used during this process to increase
model output quality and precision while also not dramatically increase runtimes. The
variable timestep function allows the user to control the computation time interval over
certain periods of the model duration. Increasing computational frequency in a desired
time period of the model will increase the accuracy of the results in that time period, then
allow the rest of the model to run on a longer time step, minimizing increase in total
processing time. In this case, a 3-minute computation interval was used for 30 hours
starting just before the water level rises, to achieve more precise computation for the
period containing the maximum inundation and peak flows. After the 30 hours elapsed,
the model would return to a 30-minute time step for the remainder of the computations.
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* To set variable timestep settings, click the El symbol next to the Computation Interval
setting.




Figure 49 Using variable time steps to increase computation frequency in a specified time
window

la ai

General| 2D Flow Options | 10/2D Cptions  Advanced Time Step Control | 1D Mied Flow Options|

" Fixed Time Step (Basic method) 30 Minute - I

(" Adjust Time Step Based on Courant

Maximum Courant:

Minimum Courant:

Number of steps below Minimum before doubling: |0
Maximum number of doubling base time step: [0 30.00 min
Maximum number of halving base time step: 0 30.00 min

—Courant Methodology
@ Courant (Velocity * dt / Length)
" Residence Time (flow out * dt / Volume)

@ Adjust Time Step Based on Time Series of Divisors Verify Dates ...

Time Step Date(ddMMMyyyy hhmm) | Divisor -
30.00 min |07MAY2018 00:00 1
180.00 sec |07MAY2018 10:00 ]
30.00 min |08SMAY2018 14:00 1

In cases where model results generated from the variable timestep settings above did not
produce the desired results (such as artificially high spikes in max flood depth, or very
sharp and frequent increases/decreases in depths throughout the model run), another
method of computational timestep determination was used. This method allowed HEC-
RAS to automatically adjust the timestep based on the computed Courant numbers
between cells in the mesh.
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Figure 50 Depth profile of a cell from Courant Method variable timestep adjustment
(MSL_c3) compared to Series of Divisors 3-min timestep selection
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Figure 51 Example settings for adjusting time step based on Courant numbers
HEC-RAS Unsteady Computation Options and Tolerances

General| 2D Flow Options | 10/2D Options  Advanced Time Step Control | 1D Mixed Flow Options|

(" Fixed Time Step (Basic method) lm
| Just Time Step Based on Courant |
Maximum Courant: |5 :
Minimum Courant: |0.5
Number of steps below Minimum before doublgig: |ﬂ
Maximum number of doubling base time step: | |1 40.00 min
Maximum number of halving base time step: 4 75.00 sec
Courant Methodology
[ )courant (veioctty * dt / Length)

" Residence Time (flow out * dt / Volume)

(" Adjust Time Step Based on Time Series of Divisors Verify Dates ...

Time Step | Date(ddMMMyyyy hhmm) | Divisor - |
1/20.00 min_|07MAY2018 00:00 1 i
2|60.00 sec |07MAY2018 05:00 200
3[20.00 min |08MAY2018 01:00 1 |
4
5
6
7
8 A

ok | cancel | Defaus..

* Once the computation interval is set and the desired run settings and file selections are
specified, Name and Save the Plan file. Give the plan an ID that will allow identification
of which boundary conditions were used in the Unsteady Flow file that is saved to that
plan.

*  Finally, hit Compute to run the model.
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Viewing Results and Generating Results Maps
* Once the model is run successfully, view the results in RAS Mapper. Open RAS Mapper to
view and generate mapping results.
e To generate results maps, right click on the plan/run of the user’s choice and select Add
New Results Map Layer. Then, select the model condition being generated, where it
should be saved, and select Add Map.




Creating new results map layers

Figure 52
EE=

i RAS Mapper

File Tools Help
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Map Layers

=) [7] Terrains Add New Results Map Layer ...
[¥] Terrain Manage Results Map Layers ...

Move Layer
Show Compute Messages ...

Geometry '(BC_AC_3')(196.8)' association was set to the
first available terrain "Terrain'

Messages | Views | Profile Lines | Active Features

Figure 53 Specifying results map type, profile, and file location
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* Once the desired results maps have been added, generate the maps. In RAS Mapper, right
click on the model run that contains the results map and select Manage Results Maps

Layers.

Map Type (selectone) —— | [ Unsteady Profile ~Map Output Mode
Water Surface Elevation - ® Maximum I Generated for Current View (in memol
Velocity b T Minimom (" Raster (with Associated Terrain)
 Profile " Point Feature Layer. ﬁl
Sigred (saved to disk
Froude 07MAY2018 01:00:00 B haster based on Terrain: [Terain =l
Residence Time (2D Only) 07MAY2018 02:00:00
Shear Stress 07MAY2018 03:00:00 " Point Feature Layer: r=3 |
Depth ™ Velocity 07MAY2018 04:00:00 c i
Depth * Velocity"2 07MAY2018 05.00:00 goygonEnidanatlalic o
Arival Time 07MAY2018 06:00:00
Recession 07MAY20138 07.00:00 =
Duration
Percent Time Inundated
Stream Power = Layer Mame: |Depth
Map Type: A Map layer will be created for Flood Inundation Depths.
Map Mode: Map results are computed using the specified Terrain and stored to disk. ‘ Add Map Cancel |




Figure 54 Computing stored results maps

\ % Manage Results Map:

View ResultMaps for  [SandyHook_MHHW-+7 ~| EI ill Compute/Update Stored Maps
Results and Maps Store Status
SandyHook_MHHW:7 Add New Map
Depth (07MAY2018 06:00:00) NJA Edit Map
Velocity (Max) NJA Edit Map
WSE (Max) NJA Edit Map

Depth (Max) ™= Map not created I Edit Map
Depth (07MAY2018 00:00:00) & EditMap | |

* Now, select the results map being generated, and hit Compute/Update Stored Maps. This
will generate a results map and store it in the HEC-RAS project folder in .tiff format.
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Appendix A: Data Sources and Uses for Floodplain Modeling and Mapping

Data Type Data Source Data Use
Coastal Water Surface A Process for Analyzing Current and Future Coastal Flood . .
. . Used for boundary condition water surface elevations for coastal watersheds.
Elevations Exposures Using a Total Water Levels Approach (Sept. 18)
2015 CoNED NJ/DE DEM (3.28’) o
. . . Used to create terrain files for HEC-RAS 2D models. All DEMs converted to
Digital Elevation Model (Link) . . . s
3.28’ cell size and mosaiced together in GIS. Each terrain file for each
(DEM) 2016 CoNED NE DEM (3.28') .
. watershed may contain DEM data from both sources.
(Link)
2011 NLCD (Non-NJ Areas) NLCD Manning’s n values were matched to most similar NJDEP Land Use
Land U (Link) category Manning’s n and updated in the HEC-RAS 2D model.
and Use
2012 NJ Statewide Land Use (NJ Areas — 2015 Update) Land Use data used for land surface friction values in HEC-RAS 2D models, and
(Link) for determining curve numbers for HEC-HMS models.
2006 NOAA Precipitation Frequency Data Server (PFDS)
Precipitation GIS Format Precipitation Depth Raster Files Input into HEC-HMS to determine excess rainfall for HEC-RAS 2D models.
(Link)
. NRCS WebSoilSurvey (SSURGO Data) . .
Soils . Combined with land use data to create curve numbers for HEC-HMS models.
(Link)
st " 2016 National Hydrography Dataset (NHD) Stream lines used to hydrologically correct DEMs, in ArcHydro Tools
reamlines
(Link) processing.




42

Appendix B: Assigned Roughness Coefficients of NJDEP Land Use Types

NJDEP Land Use Category Code Manning N Manning's N Source

Agricultural Wetlands Cranberry Farms & Modified
Uplands 2140 0.1 NLCD Emergent Herbaceous Wetlands
Airport Facilities 1440 0.013 NLCD Developed, Open Space
Altered Lands 7400 0.03 NLCD Barren Land
Artificial Lakes 5300 0.03 NLCD Open Water
Athletic Fields Schools 1804 0.03 NLCD Grassland/Herbaceous
Atlantic Ocean 5430 0.03 NLCD Open Water
Atlantic White Cedar Wetlands 6221 0.1 NLCD Woody Wetlands
Bare Exposed Rock, Rockslides, etc. 7200 0.03 NLCD Barren Land
Bays, Estuaries & other Tidal Waters 5400 0.03 NLCD Open Water
Beaches 7100 0.03 NLCD Barren Land
Bridge Over Water 1419 0.013 NLCD Developed, Open Space
Brush-Dominate and Bog Wetlands 6230 0.1 NLCD Emergent Herbaceous Wetland
Brushland/Shrubland 4400 0.05 NLCD Scrub/Shrub

TR-55 Table 3-1 Trees: Cleared land with tree stumps,
Cemetery 1710 0.04 no sprouts

TR-55 Table 3-1 Trees: Cleared land with tree stumps,
Cemetery on Wetland 1711 0.04 no sprouts
Coastal Wetlands 6100 0.1 NLCD Emergent Herbaceous Wetland
Commercial and Services 1200 0.1 NLCD Developed, High Intensity
Confined Feeding Operations 2300 0.05 NLCD Developed, low intensity.

TR-55 Table 3-1 Trees: Same as above, but heavy
Coniferous Brush/Shrubland 4430 0.1 sprouts
Coniferous Forest 4200 0.12 NLCD Evergreen Forest
Coniferous Forest >50% Crown Closure 4220 0.16 NLCD Evergreen Forest (maximum)
Coniferous Forest 10-50% Crown Closure 4210 0.1 NLCD Evergreen Forest (minimum)
Coniferous Scrub/Shrub Wetlands 6232 0.1 NLCD Emergent Herbaceous Wetland
Coniferous Wooded Wetlands 6220 0.1 NLCD Woody Wetlands
Cropland and Pastureland 2100 0.04 NLCD Pasture/Hay

TR-55 Table 3-1 Trees: Same as above, but heavy
Deciduous Brush/Shrubland 4420 0.1 sprouts
Deciduous Forest 4100 0.12 NLCD Deciduous Forest
Deciduous Forest >50% Crown Closure 4120 0.16 NLCD Deciduous Forest (maximum)
Deciduous Forest 10-50% Crown Closure 4110 0.1 NLCD Deciduous Forest (minimum)
Deciduous Scrub/Shrub Wetlands 6231 0.1 NLCD Emergent Herbaceous Wetland
Deciduous Wooded Wetlands 6210 0.1 NLCD Woody Wetlands
Disturbed Tidal Wetlands 7440 0.1 NLCD Emergent Herbaceous Wetland
Disturbed Wetlands Modified 7430 0.1 NLCD Emergent Herbaceous Wetland
Dredged Lagoon 5420 0.03 NLCD Open Water
Exposed Flats 5190 0.03 NLCD Grassland/Herbaceous
Extractive Mining 7300 0.03 NLCD Barren Land
Former Agricultural Wetlands Becoming Shrubby not
Built-up 2150 0.1 NLCD Woody Wetlands
Former Military; Indeterminate Use 1214 0.075 NLCD Developed, Medium Intensity
Freshwater Tidal Marshes 6120 0.1 NLCD Emergent Herbaceous Wetland
Herbaceous Wetlands 6240 0.1 NLCD Emergent Herbaceous Wetland
Industrial 1300 0.1 NLCD Developed, High Intensity
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Industrial and Commercial Complexes 1500 0.1 NLCD Developed, High Intensity
Interior Wetlands 6200 0.1 NLCD Woody Wetlands
Major Roadway 1410 0.013 NLCD Developed, Open Space
Managed Wetland, in Built-up Maintained Rec Area 1850 0.05 NLCD Scrub/Shrub
Managed Wetland, in Maintained Lawn Green space 1750 0.05 NLCD Scrub/Shrub
Managed Wetlands Modified 8000 0.075 NLCD Emergent Herbaceous Wetland (minimum)
Military Installations 1211 0.075 NLCD Developed, Medium Intensity
TR-55 Table 3-1 Trees: Same as above, but heavy
Mixed Deciduous/Coniferous Brush/Shrubland 4440 0.1 sprouts
Mixed Forest 4300 0.12 NLCD Deciduous Forest
Mixed Forest >50% Coniferous with >50% Crown Closure 4312 0.16 NLCD Evergreen Forest (maximum)
Mixed Forest >50% Coniferous with 10-50% Crown
Closure 4311 0.1 NLCD Evergreen Forest (minimum)
Mixed Forest >50% Deciduous with >50% Crown Closure 4322 0.16 NLCD Deciduous Forest (maximum)
Mixed Forest >50% Deciduous with 10-50% Crown Closure 4321 0.1 NLCD Deciduous Forest (minimum)
Mixed Forested Wetlands Coniferous Dom. 6252 0.1 NLCD Woody Wetlands
Mixed Forested Wetlands Deciduous Dom. 6251 0.1 NLCD Woody Wetlands
Mixed Residential 1150 0.075 NLCD Developed, Medium Intensity
Mixed Scrub/Shrub Wetlands Coniferous Dom. 6234 0.1 NLCD Emergent Herbaceous Wetland
Mixed Scrub/Shrub Wetlands Deciduous Dom. 6233 0.1 NLCD Emergent Herbaceous Wetland
Mixed transportation Corridor Overlap Areas 1411 0.05 NLCD Developed, Low Intensity
Mixed Urban or Built-up Land 1600 0.075 NLCD Developed, Medium Intensity
Mixed Wooded Wetlands 6250 0.1 NLCD Woody Wetlands
Natural Lakes 5200 0.03 NLCD Open Water
Old Field < 25% Brush Covered 4410 0.04 NLCD Pasture/Hay
Open Tidal Bays 5411 0.03 NLCD Open Water
Orchards, Vineyards, Nurseries, Horticultural Areas, Sod
Farms 2200 0.035 NLCD Cultivated Crops
Other Agriculture 2400 0.035 NLCD, Cultivated Crops
Other Urban or Built-up Land 1700 0.075 NLCD Developed, Medium Intensity
Phragmites Dominate Coastal Wetlands 6141 0.1 NLCD Woody Wetlands
Phragmites Dominate Interior Wetlands 6241 0.1 NLCD Woody Wetlands
Phragmites Dominate Old Field 4411 0.05 NLCD Scrub/Shrub
Phragmites Dominate Urban Area 1741 0.1 NLCD Woody Wetlands
Plantation 4230 0.035 NLCD Cultivated Crops
Railroad Facilities 1420 0.05 NLCD Developed, Low Intensity
Recreational Land 1800 0.013 NLCD Developed, Low Intensity
Residential 1100 0.075 NLCD Developed, Medium Intensity
Residential High Density or Multiple Dwelling 1110 0.1 NLCD Developed, High Intensity
Residential Rural, Single Unit 1140 0.013 NLCD Developed, Open Space
Residential Single Unit, Low Density 1130 0.05 NLCD Developed, Low Intensity
Residential Single Unit, Medium Density 1120 0.075 NLCD Developed, Medium Intensity
Saline Marshes 6110 0.1 NLCD Emergent Herbaceous Wetland
Saline Marshes High marsh vegetation 6112 0.15 NLCD Emergent Herbaceous Wetland (maximum)
Saline Marshes Low marsh vegetation 6111 0.075 NLCD Emergent Herbaceous Wetland (minimum)
Severe Burned Upland Vegetation 4500 0.03 NLCD Barren Land
Severe Burned Wetlands 6500 0.075 NLCD Emergent Herbaceous Wetland (minimum)
Stadium, Theaters, Cultural Centers, and Zoos 1810 0.075 NLCD Developed, Medium Intensity
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Stormwater Basin 1499 0.013 NLCD Developed, Open Space
Streams and Canals 5100 0.03 NLCD Open Water

Tidal Mud Flats 5412 0.03 NLCD Barren Land

Tidal Rivers, Inland Bays and other Tidal Waters 5410 0.03 NLCD Open Water

Transitional Areas sites under construction 7500 0.075 NLCD Emergent Herbaceous Wetland (minimum)
Transportation/Communication/Utilities 1400 0.05 NLCD Developed, Low Intensity
Undifferentiated Barren Lands 7600 0.03 NLCD Barren Land

Unvegetated Flats 6290 0.03 NLCD Barren Land

Upland Rights-of-Way, Developed 1462 0.013 NLCD Developed, Open Space

Upland Rights-of-Way, Undeveloped 1463 0.03 NLCD Barren Land

Vegetated Dune Communities 6130 0.05 NLCD Scrub/Shrub

Wetland Rights-of-Way 1461 0.1 NLCD Emergent Herbaceous Wetlands
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Appendix C: Assigned Curve Number by NJDEP Land Use Type and HSG

SCS Curve Number

LU7Code | NJDEP - Anderson_Type TR-55_Type B C D Notes and Assumptions
RESIDENTIAL, HIGH DENSITY OR MULTIPLE Residential (1/8
1110 | DWELLING acre) 77 85 90 92
Residential (1/3
1120 | RESIDENTIAL, SINGLE UNIT, MEDIUM DENSITY acre) 57 72 81 86
Residential (1
1130 | RESIDENTIAL, SINGLE UNIT, LOW DENSITY acre) 51 68 79 84
Residential (2
1140 | RESIDENTIAL, RURAL, SINGLE UNIT acres) 46 65 77 82
Residential
(averaged over Average of 1110-1140
1150 | MIXED RESIDENTIAL lot sizes) 58 73 82 86
Urban districts
(commercial
1200 | COMMERCIAL/SERVICES and business) 89 92 94 95
Urban districts
(commercial
1211 | MILITARY INSTALLATIONS and business) 89 92 94 95
Urban districts
(commercial
1214 | NO LONGER MILITARY and business) 89 92 94 95
Urban districts
1300 | INDUSTRIAL (industrial) 81 88 91 93
Impervious
Areas (Paved,
1400 | TRANSPORTATION/COMMUNICATION/UTILITIES open ditches) 83 89 92 93
Impervious
Areas (Streets
and roads,
1410 | MAJOR ROADWAY paved, curbs) 98 98 98 98
Impervious
Areas (Paved,
1411 | MIXED TRANSPORTATION CORRIDOR OVERLAP AREA | open ditches) 83 89 92 93
Impervious
Areas (Paved,
1419 | BRIDGE OVER WATER open ditches) 83 89 92 93
Impervious
1420 | RAILROADS Areas (Gravel) 76 85 89 91
Impervious
Areas (Paved,
1440 | AIRPORT FACILITIES open ditches) 83 89 92 93
Assumed woodlands
wetland with higher runoff
1461 | WETLAND RIGHTS-OF-WAY Woods (Poor) 45 66 77 83
Residential
(averaged over Averaged
1462 | UPLAND RIGHTS-OF-WAY DEVELOPED lot sizes) 58 73 82 86
1463 | UPLAND RIGHTS-OF-WAY UNDEVELOPED Woods (Fair) 36 60 73 79
Open space
1499 | STORMWATER BASIN (good) 39 61 74 80
Urban districts
(commercial
1500 | INDUSTRIAL AND COMMERCIAL COMPLEXES and business) 89 92 94 95
Residential
(averaged over Averaged
1600 | MIXED URBAN OR BUILT-UP LAND lot sizes) 58 73 82 86




Residential
(averaged over
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Averaged

1700 | OTHER URBAN OR BUILT-UP LAND lot sizes) 58 73 82 86
Open space
1710 | CEMETERY (good) 39 61 74 80
Assumed cemetery with
Open space higher runoff
1711 | CEMETERY ON WETLAND (poor) 68 79 86 89
1741 | PHRAGMITES DOMINATE URBAN AREA Brush (Fair) 35 56 70 77
MANAGED WETLAND IN MAINTAINED LAWN Open space
1750 | GREENSPACE (fair) 49 69 79 84
Open space
1800 | RECREATIONAL LAND (fair) 49 69 79 84
Open space
1804 | ATHLETIC FIELDS (SCHOOLS) (good) 39 61 74 80
Urban districts
(commercial
1810 | STADIUM, THEATERS, CULTURAL CENTERS AND ZOOS | and business) 89 92 94 95
MANAGED WETLAND IN BUILT-UP MAINTAINED REC | Open space
1850 | AREA (fair) 49 69 79 84
Pasture,
grassland, or
2100 | CROPLAND AND PASTURELAND range (good) 39 61 74 80
Pasture, Assumed higher runoff than
grassland, or dry pasture
2140 | AGRICULTURAL WETLANDS (MODIFIED) range (poor) 68 79 86 89
FORMER AGRICULTURAL WETLAND (BECOMING
2150 | SHRUBBY, NOT BUILT-UP) Brush (poor) 48 67 77 83
ORCHARDS/VINEYARDS/NURSERIES/HORTICULTURAL | Row Crops (SR
2200 | AREAS Good) 67 78 85 89
2300 | CONFINED FEEDING OPERATIONS Farmsteads 59 74 82 86
Pasture,
grassland, or
2400 | OTHER AGRICULTURE range (fair) 49 69 79 84
4110 | DECIDUOUS FOREST (10-50% CROWN CLOSURE) Woods (Fair) 36 60 73 79
4120 | DECIDUOUS FOREST (>50% CROWN CLOSURE) Woods (good) 30 55 70 77
4210 | CONIFEROUS FOREST (10-50% CROWN CLOSURE) Woods (Fair) 36 60 73 79
4220 | CONIFEROUS FOREST (>50% CROWN CLOSURE) Woods (good) 30 55 70 77
Row Crops (SR
4230 | PLANTATION Good) 67 78 85 89
MIXED FOREST (>50% CONIFEROUS WITH 10-50%
4311 | CROWN CLOSURE) Woods (Fair) 36 60 73 79
MIXED FOREST (>50% CONIFEROUS WITH >50%
4312 | CROWN CLOSURE) Woods (good) 30 55 70 77
MIXED FOREST (>50% DECIDUOUS WITH 10-50%
4321 | CROWN CLOSURE) Woods (Fair) 36 60 73 79
MIXED FOREST (>50% DECIDUOUS WITH >50%
4322 | CROWN CLOSURE) Woods (good) 30 55 70 77
4410 | OLD FIELD (< 25% BRUSH COVERED) Brush (poor) 48 67 77 83
4411 | PHRAGMITES DOMINATE OLD FIELD Meadow 30 58 71 78
4420 | DECIDUOUS BRUSH/SHRUBLAND Brush (good) 30 48 65 73
4430 | CONIFEROUS BRUSH/SHRUBLAND Brush (good) 30 48 65 73
MIXED DECIDUOUS/CONIFEROUS
4440 | BRUSH/SHRUBLAND Brush (good) 30 48 65 73
4500 | SEVERE BURNED UPLAND VEGETATION Brush (poor) 48 67 77 83
From U Texas Report (pg
101)
5100 | STREAMS AND CANALS See Notes 100 | 100 | 100 | 100
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From U Texas Report (pg
101)

5190 | EXPOSED FLATS See Notes 25 25 25 25
From U Texas Report (pg
101)
5200 | NATURAL LAKES See Notes 100 | 100 | 100 | 100
From U Texas Report (pg
101)
5300 | ARTIFICIAL LAKES See Notes 100 | 100 | 100 | 100
*Assumed 50% open water
(CN 98), HSG A value
TIDAL RIVERS, INLAND BAYS, AND OTHER TIDAL Herbaceous assumed
5410 | WATERS (poor)* 87.5 89 | 92.5 | 95.5
Used same values as open
water from U Texas Report
5411 | OPEN TIDAL BAYS See Notes 100 | 100 | 100 | 100
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
5412 | TIDAL MUD FLATS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 70% open water
(CN 98), HSG A value
Herbaceous assumed
5420 | DREDGED LAGOON (poor)* 91.7 | 92.6 | 94.7 | 96.5
Used same values as open
water from U Texas Report
5430 | ATLANTIC OCEAN U Texas Report 100 | 100 | 100 | 100
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6111 | SALINE MARSH (LOW MARSH) (poor)* 875 | 89| 925|955
*Assumed 70% open water
(CN 98), HSG A value
Herbaceous assumed
6112 | SALINE MARSH (HIGH MARSH) (poor)* 91.7 | 92.6 | 94.7 | 96.5
6130 | VEGETATED DUNE COMMUNITIES Brush (good) 30 48 65 73
*Assumed 70% open water
Herbaceous (CN 98), HSG A value
6120 | FRESHWATER TIDAL MARSHES (poor)* 91.7 | 92.6 | 94.7 | 96.5 | assumed
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6141 | PHRAGMITES DOMINATE COASTAL WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6210 | DECIDUOUS WOODED WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6220 | CONIFEROUS WOODED WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6221 | ATLANTIC WHITE CEDAR WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6231 | DECIDUOUS SCRUB/SHRUB WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6232 | CONIFEROUS SCRUB/SHRUB WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
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*Assumed 50% open water
(CN 98), HSG A value

MIXED SCRUB/SHRUB WETLANDS (DECIDUOUS Herbaceous assumed
6233 | DOM.) (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
MIXED SCRUB/SHRUB WETLANDS (CONIFEROUS Herbaceous assumed
6234 | DOM.) (poor)* 875 | 89925 | 955
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6240 | HERBACEOUS WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6241 | PHRAGMITES DOMINATE INTERIOR WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6251 | MIXED WOODED WETLANDS (DECIDUOUS DOM.) (poor)* 87.5 89 | 92.5 | 95.5
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
6252 | MIXED WOODED WETLANDS (CONIFEROUS DOM.) (poor)* 875 | 89| 925|955
*Assumed 20% open water
(CN 98), HSG A value
Herbaceous assumed
6290 | UNVEGETATED FLATS (poor)* 93.8 | 944 | 958 | 97
*Assumed 50% open water
(CN 98), HSG A value
assumed
Herbaceous
6500 | SEVERE BURNED WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
From U Texas Report (pg
101)
7100 | BEACHES See Notes 25 25 25 25
paved parking From EPA Report
7200 | BARE EXPOSED ROCK, ROCK SLIDES, ETC lots/bare rock 98 98 98 98
paved parking From EPA Report
7300 | EXTRACTIVE MINING lots/bare rock 98 98 98 98
Newly graded
7400 | ALTERED LANDS areas 77 86 91 94
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
7430 | DISTURBED WETLANDS (MODIFIED) (poor)* 875 | 89| 925|955
*Assumed 50% open water
(CN 98), HSG A value
Herbaceous assumed
7440 | DISTURBED TIDAL WETLANDS (poor)* 87.5 89 | 92.5 | 95.5
Newly graded
7500 | TRANSITIONAL AREAS areas 77 86 91 94
Newly graded
7600 | UNDIFFERENTIATED BARREN LANDS areas 77 86 91 94




